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Software, Inc. (“Alvaria”). Alvaria assumes no responsibility or liability for any

errors or inaccuracies that may appear in this publication. Alvaria reserves the

right to change information in this publication without notice as a result of

product enhancements or other reasons.

Alvaria™, Aspect®, Unified IP® and other marks as indicated are trademarks or

registered trademarks of Alvaria, Inc. in the United States and other countries.
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Use of any Alvaria trademark is prohibited unless expressly approved in

writing in advance by an authorized representative of Alvaria, Inc. Microsoft

Windows®, and Microsoft SQL Server® are registered trademarks or

trademarks of Microsoft Corporation in the United States and/or other

countries. Any other brands, product names, company names, logos,

trademarks, and/or service marks used in this publication are the property of

their respective owners. You may not copy, modify or display any of Alvaria’s

or its affiliates’ or licensors’ trademarks, trade names or logos appearing in

this publication in any way without Alvaria’s express written consent.

The works of authorship, including but not limited to all design, text and

images, contained and the software described in this publication are owned by

Alvaria or its affiliates or licensors, except as otherwise expressly stated. The

entire contents of this publication are protected by United States and

worldwide copyright laws and treaty provisions. In accordance with these laws

and provisions, you may not copy, reproduce, modify, use, republish, upload,

post, transmit or distribute in any way material from this publication. Further,

except as permitted by your written agreement with Alvaria, no part of this

publication may be reproduced, stored in a retrieval system, or transmitted in

any form or by any means, electronic, or otherwise, without the prior written

permission of Alvaria.

RESTRICTED RIGHTS LEGEND

This publication is provided with “Restricted Rights”. No part of this publication

may be photocopied, reproduced or transmitted, in any form or by any means,

without the prior written consent of Alvaria. Use, duplication, or disclosure by

the United States Government (“Government”) is subject to the restrictions set

forth in DFARS 252.227-7013 (b)(3) and FAR 52.227-19. Use of the materials

by the Government constitutes acknowledgement of Alvaria’s proprietary

rights in them. Alvaria is located at 211 Perimeter Center Parkway NE, Suite

250, Atlanta, GA 30346, USA.

LIMITED RIGHTS NOTICE (DEC 2007)

(a) These data are submitted with limited rights under Alvaria’s contracts with

various Government entities. These data may be reproduced and used by the

Government with the express limitation that they will not, without written

permission of the Alvaria, be used for purposes of manufacture nor disclosed
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outside the Government; except that the Government may disclose these data

outside the Government for the following purposes, if any, provided that the

Government makes such disclosure subject to prohibition against further use

and disclosure: None.

EXPORT

This item is subject to U.S. export control laws and regulations. This item may

not be exported, re-exported, re-transferred, disclosed or otherwise diverted

contrary to U.S. export control laws or regulations.

NO WARRANTY

THE CONTENTS OF THIS PUBLICATION ARE PROVIDED “AS IS” WITHOUT

WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT

NOT LIMITED TO, THE IMPLIED WARRANTIES OF QUALITY,

MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, NON-

INFRINGEMENT, OR THAT OPERATION OF THE PRODUCTS SOLD BY ALVARIA

WILL BE UNINTERRUPTED OR ERROR FREE.

NO LIABILITY

ALVARIA, ITS AFFILIATES, AND LICENSORS ARE NOT LIABLE FOR ANY

DAMAGES SUFFERED AS A RESULT OF USING THE CONTENTS OF THIS

PUBLICATION. IN NO EVENT WILL ALVARIA, ITS AFFILIATES OR LICENSORS

BE LIABLE FOR ANY (i) CONSEQUENTIAL, INDIRECT, PUNITIVE, SPECIAL, OR

INCIDENTAL DAMAGES, (ii) ANY INTERRUPTION OF BUSINESS OR

OPERATIONS, COST OF COVER, GOODWILL, TOLL FRAUD, OR LOSS OF

DATA, PROFITS, OR REVENUE, OR (iii) FAILURE OF A REMEDY TO ACHIEVE

ITS ESSENTIAL PURPOSE. THE LIMITATIONS IN THIS SECTION WILL APPLY

TO ANY DAMAGES, HOWEVER CAUSED, AND ON ANY THEORY OF LIABLITY,

WHETHER FOR BREACH OF CONTRACT, TORT, MISREPRESENTATION,

NEGLIGENCE, THE USE OR PERFORMANCE OF A PRODUCT OR SERVICE, OR

OTHERWISE AND REGARDLESS OF WHETHER THE DAMAGES WERE

FORESEEABLE OR UNFORSEEABLE. NEITHER PARTY WILL BE LIABLE FOR

ANY CLAIM BROUGHT BY THE OTHER PARTY MORE THAN 12 MONTHS

AFTER THE OTHER PARTY BECAME AWARE OF THE ISSUE GIVING RISE TO

THE CLAIM. ALVARIA’S, ITS AFFILIATES’ OR LICENSORS’ FAILURE TO

EXERCISE A RIGHT OR REMEDY IS NOT A WAIVER. BECAUSE SOME

JURISDICTIONS PROHIBIT THE EXCLUSION OR LIMITATION OF LIABILITY
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FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION

MAY NOT APPLY TO YOU.

PROGRAMMING AND USE OF PRODUCTS

THE PRODUCTS DESCRIBED IN THIS PUBLICATION CAN BE USED AND

PROGRAMMED IN A WIDE VARIETY OF WAYS BASED ON THE

REQUIREMENTS OF YOUR PARTICULAR TECHNOLOGY, ENVIRONMENT AND

BUSINESS. NOTWITHSTANDING THE USE OF EXAMPLES IN THIS

PUBLICATION OR THE PROVISION OF PROFESSIONAL SERVICES BY ALVARIA,

ALVARIA RESELLERS, OR ANY THIRD PARTY ENGAGED BY ALVARIA, IT IS IN

ALL CASES YOUR RESPONSIBILITY TO ENSURE THAT THE PRODUCTS ARE

PROGRAMMED AND USED IN ACCORDANCE WITH ALL APPLICABLE LAWS

AND REGULATIONS AND IN A MANNER THAT DOES NOT VIOLATE THE

INTELLECTUAL PROPERTY OR OTHER RIGHTS OF ANY THIRD-PARTY.

Rev A

November 7, 2025

About this guide

This guide is designed for Aspect Cloud Workforce (the New Experience)

users, including both administrators and employees. It provides

comprehensive instructions for getting started, managing accounts, and

utilizing key features of the platform. 

The guide is organized into sections based on user roles and common tasks,

with expandable toggles that allow you to quickly navigate to the specific

information you need. Simply click on any toggle to reveal detailed step-by-

step instructions, helpful tips, and visual aids. 

Whether you're registering your account for the first time, managing user

invitations as an admin, or adjusting your personal settings, you'll find clear

guidance throughout this documentation.

Aspect Cloud Workforce (the New Experience) overview

Aspect Cloud Workforce (the New Experience) simplifies and optimizes

schedule management by aligning employee preferences with business needs

while addressing overstaffing and understaffing challenges. Meticulously

designed to meet contemporary business needs without the burden of
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unnecessary features, the New Experience offers a simplified user interface

with streamlined scheduling, proactive notifications, easy shift management,

and predictive insights on shift approvals. 

Built with privacy in mind, The New Experience gives employees increased

agency over their schedules, improving job satisfaction and streamlining

operational efficiencies - all while protecting user privacy. The New

Experience also seamlessly integrates with Aspect Workforce Management

(WFM), offering a unified platform to manage schedules and preferences that

foster better communication and collaboration across teams, ultimately

boosting productivity. 

If you have already signed up for the New Experience, open the email

invitation from the Aspect team and register your account.

The New Experience is now available in the US, EU, UK, and Canada.

Aspect Intelligence™ overview

Aspect Cloud Workforce (the New Experience) now includes Aspect

Intelligence™, a new capability that helps enterprises shift from static

workforce planning to real-time operational control.

Aspect Intelligence™ is designed to help teams spot risk earlier and act faster,

reducing the time and effort spent on last-minute adjustments when plans

change.

Aspect Cloud Workforce (the New Experience) advances Aspect Intelligence™

with enhanced AI and purposeful automation, enabling the platform to not only

forecast demand but also initiate timely operational adjustments. These

capabilities reduce manual intervention, strengthen forecast reliability, and

help maintain staffing alignment with real-world conditions.

Aspect Intelligence™ enables Automated Schedule Updates that allow admins

to automatically add the correct schedule segment when cleared adherence

alarms fire—eliminating manual schedule fixes.

Aspect Intelligence™ is now available in the U.S., U.K., Europe, and Canada.

All users: Register your account                                          
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⚠️ Registering your account by email is only needed for unfederated

users. The email registration process does not apply to federated

users. 

1. Open the email titled, “Accept your invitation to Aspect Workforce

Experience” and click Accept your invite to Workforce Experience.

⚠️ The invite email includes the account name you will use to log into

the New Experience. The invite email will expire after 7 days. If the

email expires, contact your Workforce Administrator to resend the

email.

2. You will be redirected to the Let’s Get Started page. 

Figure 1-1
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💡 When Federated Login is enabled on your account, you will not be

required to create and confirm a password. You will be redirected to

your company's authentication provider to verify your identity. If you

have already authenticated in your current browser session, you will

be automatically logged into the New Experience. 

3. Type your first and last name. 

4. The account name will be preselected for you. 

5. Select an answer from the drop-down menu that describes your work.

6. Create and confirm a password. 

7. Select the check box to accept the terms and conditions and privacy

policy. 

8. When you are finished, click Get Started.

9. You are now logged into the New Experience. The next time you need to

log in, visit the login page. 

Figure 1-2
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💡 See how Admins can send invites for the New Experience to other

Admins or Employees.

Back to top

All users: Log in to Aspect Cloud Workforce (the New Experience)

1. Open the New Experience, select or type your Account name and click 

Continue.

💡 When Federated Login is enabled on your account, you will be

redirected to your company's authentication provider to verify your

identity. If you have already authenticated in your current browser

session, you will be automatically logged into the New Experience. 

⚠️ If you don’t know your Account name, look for it in the invite email or

contact your Workforce Administrator for more help.

Figure 1-1
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2. Type your email (where you received the invite email) and password and

click Login. See how to reset your password if needed. 

Back to top

All users: Adjust the Timezone, Time Format, or Date and Number format

The New Experience automatically displays dates, times, numbers, and

currency in formats familiar to each user by detecting and applying their

regional settings.

Personal Settings include:

Time zone selection

12-hour or 24-hour clock format

Regional settings

1. Open the New Experience and log in.  

2. In the upper right corner, click the Profile icon and click Personal

Settings.

Figure 1-2
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💡 Some administrator features will reflect the selections made in their

personal settings.

Users can view forecasts in their preferred time zone, though

this is not the default setting. Administrators can view schedules

across different time zones. The date and time format for created

and updated apps will follow the user's time zone settings.

View My Team's Schedule: Time zones can be manually selected

on this page..

All elements will follow the user's preferred clock settings. The

time zone will reflect the routing set, forecast, and staff group

time zone. Administrators can view schedules in different time

formats (12-hour or 24-hour).

All elements will follow the users Region setting for date/time,

digit.

3. Select an option from the Timezone drop-down menu and click Save

Settings. 

Figure 1-1
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4. Select a radio button next to your preferred time format and click Save

Settings.

5. Select an option from the Date & Number Format drop-down menu and

click Save Settings.

Figure 1-2

Figure 1-3
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6. The changes are now updated.

Figure 1-5

Back to top

All users: Overview of roles in Aspect Cloud Workforce (the New

Experience)

Figure 1-4
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💡 Access and permissions for Employees and Regular Users in the

New Experience are linked to WFM security profile settings.

The Developer Role will be available to assign to a new user or

existing user in the User Management settings.

The New

Experience Role
Feature Access Backend Integration WFM Role

Admin

• Access to all

features except

Employee features.

• Admin Users are

created, edited,

deactivated and/or

deleted in the New

Experience.

Admin

Regular User

• View Team

schedules

• Edit Team schedules

(with permissions

from WFM)

• Regular Users are

created, edited,

deactivated, and/or

deleted in WFM.

Regular User

Employee

• Access to Employee

Scheduling features

and Performance

Hub.

• Employee Users are

created, edited,

deactivated, and/or

deleted in WFM.

Employee

Admins will have access to all functionality listed in the Admin

Management section.

Employees  will have access to all functionality listed in the Employee

Schedule Management section.

Regular users can view team or employee schedules, but they cannot edit

schedules unless they have the appropriate WFM permissions.

Admin Management 👤
Admin: Dashboard overview
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The Admin Dashboard has three main sections, accessible from the menu on

the left of the screen:

Team Management and Team Schedules: The Team Schedules view

gives Admins full schedule visibility to manage their employees or

teams effectively. 

Forecast (Beta): The Forecast Dashboard view provides two ways to

view forecast data. The Intelligent view displays forecasts using AI-

generated data, while the Classic view shows user-created WFM

forecasts. 

User Management: The User Management view allows you to manage

the activation status for all users in your account. As an Admin, this is

where you can activate, invite, or remove a user from your account. 

Workflow Catalog: The Workflow catalog allows Admins to create,

configure, and manage Agents workflows. It is divided into two

sections: Workflow Catalog and Workflow Builder.

If you are using a Federated environment, learn how it impacts your user

management experience. 

We recommend reviewing the articles in this section to familiarize yourself

with the Admin features available in the New Experience. 

Figure 1-1
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Admin: Federated environment overview

What is a Federated environment?

A Federated environment or Federated login eliminates inconsistent

authentication across Aspect products.

Using a standards-based Single Sign On (SSO) approach, it allows Aspect

Cloud Workforce (the New Experience) users to sign in through their

organization’s existing Identity Provider (IdP), creating a smoother and

more secure experience. 

This eliminates the need for users to register for an account or create and

maintain separate credentials for the New Experience.

💡 The New Experience Enablement Information

Federated Login for Aspect Cloud Workforce (the New

Experience) is compatible with Azure Entra ID and OKTA

(additional providers will be added soon)

Configured independently in IdP (on client side) from any

existing Aspect products (WEM, WFM)

Uses SAML 2.0 standard

Service Provider (SP) initiated login (IdP initiated is not available

at this time but may be in the future)

What are the benefits of Federated Login?

Federated Login provides significant benefits to New Experience users and to

your organization’s administrators.

Single sign on (SSO) – When a user's organization account is linked to

their Aspect account, they no longer need to remember a New Experience

username and password. Instead, they access the New Experience by

logging in with their organization account credentials. 
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Organizational control over the login process – Because users log in

through their organization's accounts, the organization maintains full

control over the login process and credentials. This allows them to set

their own requirements for password length, complexity, change

frequency, two-factor authentication, and other security policies.

Automated Onboarding - After Workforce integration and Federation

activation in the New Experience, all employee users from WFM will be

automatically activated in the New Experience. This removes the

requirement for employees to register for the New Experience. 

How will this impact users registering an account and logging in?

Employees and Admins do not need to take any action for Federated Login

setup. Their IdP SSO credentials are managed entirely through their

organization's identity provider.

After Workforce Integration and Federation activation in the New Experience,

all employee users from WFM will be automatically activated in the New

Experience and will not need to register for a New Experience account. 

How do I request enablement for Federated Login?

💡 If you do not currently have the New Experience but plan to

implement it in the future, federation will be discussed as an

option with your team during that engagement process.

If you currently have the New Experience but do not have

federation enabled, contact your Aspect account representative

to request Federated Login setup.

1. Your Aspect account representative will coordinate with the appropriate

Aspect resources and schedule a meeting to discuss your requirements

and configuration details.

2. Our Aspect Federation Enablement team will provide these required

identity provider (IdP) details (needed for Step 3):
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Identifier (Entity ID)

Reply URL (ACS URL)

Required SAML attributes

3. Your organization will configure the New Experience as a Service Provider

(SP) within your identity provider (IdP).

4. You will send Aspect the IdP metadata configuration details as a 

metadata.xml file or URL (Required for Step 5).

5. The Aspect Federation Enablement team will implement the Service

Provider (SP) configurations within the New Experience.

6. The Aspect team will conduct quality assurance testing and notify you

when configuration is complete.

7. Your organization can then test and verify that Federated Login functions

properly in the New Experience.

Back to top

Admin: User Management overview

💡 The User management view gives Admins a single place to manage

all users in the account. From here, you can search and filter, invite

new Admins or activate Employees, and view each person’s status at

a glance—Active, Available, Pending, or Deactivated. 

For unfederated tenants, you can resend and deactivate or delete

Admins as needed, while federated environments automatically

activate WFM users after integration and federation are enabled. 

Use this view to keep your team list accurate and up to date, and to

quickly take the right action when someone joins, changes roles, or

leaves.

1. Click User management to display the User management view. The total

number of Admins, Regular Users, and Employees appears at the top of

the screen. 
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2. Click Edit Columns to add, remove, or reorder the columns. Click Apply

when you are done editing.

3. Click one of the links below for more information on user management

tasks you can perform as an Admin.

Learn how to search or filter the list of users.

Learn how to activate an Admin or Employee account.

Learn how to edit an employee role or update user info.

Figure 1-1

Figure 1-2
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Learn how to check the status of a user.

Learn how to resend an email invitation or delete/deactivate a user.

Back to top

Admin: Activate an account for an Admin

💡 To activate another Admin user, follow the steps below. Invitation

emails will only be sent to unfederated accounts. 

1. Open the New Experience and log in. 

2. Expand Admin, click User management and in the upper-right corner,

click Invite Admin. 

3. Type the Admin email address and click Invite. 

Federated tenant: Admin will appear with Available status and change

to Active when they log in. 

Unfederated tenant: Admin will receive an invitation email with login

instructions. 

Figure 1-1
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⚠️ For Unfederated tenants, invites expire after 7 days. If the invite

expires, resend the invite. See how to check the status of an invite.

Sending admin invites in bulk is not available yet but will be added

soon. 

Back to top

Admin: Activate an account for an Employee or Regular user

⚠️ Employee or Regular user email addresses must be registered and

activated in Aspect WorkforceOS, before they can be activated in the

New Experience. You can not add Employee or Regular user emails

directly from the New Experience.

Figure 1-2
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⚠️ For Federated tenants, all WFM Employee or Regular users will

automatically be activated once Workforce integration and

Federation activation are complete in the New Experience—no

separate registration is required. 

Follow the steps below to activate an employee. The employee or

regular user must be in Available status to be activated. 

1. Open the New Experience and log in. 

2. Click User management and use the search or filtering options to locate

the employee(s) in Available status you want to activate. 

3. Select the check boxes next to the employee names, click Actions and

select Invite Users. 

Figure 1-1
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4. Review the selected email addresses and click Invite. 

Figure 1-2

Figure 1-3

Aspect Cloud Workforce (the New Experience) 22



⚠️ If your account is Unfederated, the employees or regular

users will receive invitation emails with log in instructions.

Invites expire after 7 days. If the invite expires, resend the

invite. See how to check the status of an invite. 

If your account is Federated, employees will NOT receive

invitation emails with login instructions. You need to share

the login page link directly with them.

Back to top

Admin: Search or filter the list of users

Use the Search Bar

1. Open the New Experience.

2. Expand Admin and click User management.

3. Type your search criteria in the search bar and press Enter. In this

example we entered Stan because we are searching for the name of the

user. You can search by name, email, role, or status. 

💡 When using the Search bar, you can enter the partial or full entry of

your search criteria. The search will compile results for all the

filtering options (Name, Email, Role, Status). 
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Use the Filtering Options

1. Open the New Experience.

2. Expand Admin and click User Management.

3. Click Filter and select a filtering option. You can filter by Name, Email,

Role, Status, or Created date. In this example, we selected Role.

Figure 1-1

Figure 2-1
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3. In the first drop-down menu, select a filtering option. Then enter your

search criteria and click Apply. In this example, we selected contains and

entered Admin.  

💡 The filtering menu options will change depending on the filter type

you select. Name and Email filter types will only display the equal to

(=) option. Role and Status types will display the options below.

Created type will display options that relate to specific date ranges.

When contains is selected, you can search for the criteria by

entering one or more letters.

When equal to (=) is selected, the search criteria must be an

exact match. 

When excludes (! =) is selected, the criteria entered will be

excluded from the search results.

4. All users with Admin roles are now displayed. You can edit or remove the

filtering options at any time.

Figure 2-2
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Back to top

Admin: Edit user info

💡 You can only edit user information for Admins. You must edit

employee information in WFM.

1. Open the New Experience and log in.  

2. Click User management and use the search or filtering options to locate

the admin whose info you want to edit. You can also use the navigation

buttons at the bottom of the page to browse through users. 

Figure 2-3
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3. Make your edits to the user info and click Update. The changes will be

automatically updated. 

Back to top

Figure 1-1

Figure 1-2

Aspect Cloud Workforce (the New Experience) 27

https://www.notion.so/c8bc9f94cd07822588ff01cde11ab3b8?pvs=25


Admin: Check the status of a user 

1. Open the New Experience and log in.  

2. Expand Admin, click User management and use the search or filtering

options to locate the user whose status you want to check. You can also

use the navigation buttons at the bottom of the page to browse through

users. 

3. In the Status column, you can view the status of all users in your account.

There are four possible statuses:

Active: The user has accepted the invite email and has an active

account.

Available: The user has a WFM account but has not been invited to

activate their New Experience account. 

Pending: The user has been sent an invite email, but has not accepted

the invite email and does not have an active account.

Deactivated: The user was activated but has been deactivated. They

can be reactivated by resending an email invitation.

Admin: Resend an email invitation

Figure 1-1
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⚠️ You can only resend email invites to users in Pending or 

Deactivated status.

Federated tenants do not have the option to resend email invitations.

1. Open the New Experience and log in. 

2. Expand Admin and click User management, then use the search or

filtering options to locate the user you want to resend the invitation to. You

can also use the navigation buttons at the bottom of the page to browse

through users. 

3. In the row of the user, click the arrow icon to resend the email invitation. 

4. Click Resend.

Figure 1-1
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Back to top

Admin: Delete or deactivate a user from your account

⚠️ Deleting or deactivating Employees must be done in WFM to comply

with GDPR requirements. You can not delete an Employee from the

New Experience.

Follow the steps below to delete or deactivate an Admin. You can

reactivate a deactivated user at any time, but deletion is permanent. 

1. Open the New Experience and log in. 

2. Expand Admin, click User Management and use the search or filtering

options to locate the Admin you want to delete or deactivate from the

account . You can also use the navigation buttons at the bottom of the

page to browse through users. 

3. Click the Remove user icon.

Figure 1-2
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4. Click Delete or Deactivate.

⚠️ Deleting a user is permanent. 

You can reactivate a deactivated user at anytime by resending an

email invitation.

Figure 1-1
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Back to top

Admin: How to use the Forecast Dashboard (Beta)

💡 The Forecast Dashboard is currently in beta. 

Overview

The latest version of the Forecast Dashboard adds comparison capabilities

that let managers and supervisors overlay and compare AI (Intelligent)

forecasts, classic WFM forecasts, and actual  volume outcomes in a single

visualization. 

This gives New Experience users better validation (closing the gap with WEM’s

export functionality) and delivers the long-requested in-platform actuals

comparison. It eliminates the need to export data or switch tools to validate

forecast accuracy. 

The forecast horizon has been extended from 4 weeks to 10 weeks, so

planners can rely on Aspect Intelligence earlier in their planning cycle, not just

as a final validation step.

Figure 1-2
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The Forecast Dashboard provides three ways to view and compare forecast

data:

The Intelligent model displays forecasts using AI-generated data

The Classic model shows user-created WFM forecasts

The Actual data retrieves and displays actual historical volume data for the

selected forecast group and time range to serve as the ground truth for

comparison.

Click a link below to see more information on the Forecast Dashboard:

Requirements

Intelligent Forecasts

Classic Forecasts

How to use the Forecast Dashboard

Requirements to Perform Call Volume Forecasting

You must be onboarded to the New Experience and AI platforms.

You must create an inbound or outbound Voice Forecast group in WFM

and configure it with a name and time zone. 

The forecast group must have associated Call Volume ACD data. 

Optionally, the forecast group can be configured with open hours and

past or future holiday factors.

Each forecast group requires a minimum of 280 days of historical data.

Intelligent Forecasts
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💡 Intelligent model forecasts provide an auto-generated forecast

solution for each WFM forecast group and update daily. They save

time for workforce analysts and planners by generating updated

forecasts using Aspect's predictive AI model.

Currently, the Intelligent model displays only the Volume Type

Forecast. These forecasts are created automatically and update daily

at midnight UTC, covering a ten-week period.

You can select one or more Intelligent forecasts to compare with Classic

forecasts, or with Actual Data. The latest Intelligent forecast will be shown at

the top of the table.

1. Expand Admin, click Forecast.

2. To view Intelligent forecasts, click Filters, expand Model and select the

checkbox next to Intelligent. You can also click the top of the Model

column to sort forecasts by model type. 

Figure 1-1
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3. Select the checkbox next to the Intelligent forecast you want to view. The

graph displays AI-generated data. 

5. See more information on how to manage the visual display settings for

your forecasts.

Classic Forecasts

💡 Classic forecasts displayed in the dashboard have been previously

generated in Workforce Management (WFM). Users must generate

forecasts in WFM prior to viewing them in the Forecast Dashboard.

Classic forecasts are generated based on actual load history from

Workforce Management (WFM) for each part of the day, calculating

the required load to handle work during these periods. 

There are three types of Classic forecasts available: Call Volume, 

Workload, and Staffing.

You can select one or more Classic forecasts to compare with Intelligent

forecasts, or with Actual Data. The latest Classic forecast will be shown at the

top of the table.

1. Expand Admin, click Forecast.

Figure 1-2
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2. To view Classic forecasts, click Filters, expand Model and select the

checkbox next to Classic. You can also click the top of the Model column

to sort forecasts by model type. 

3. Select the checkbox next to the Classic forecast you want to view. The

graph displays AI-generated data. 

Figure 2-1

Figure 2-2
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4. See more information on how to manage the visual display settings for

your forecasts.

Use the Forecast Dashboard

💡 The Forecast Dashboard provides three ways to view and compare

forecast data:

The Intelligent model displays forecasts using AI-generated data

The Classic model shows user-created WFM forecasts

The Actual data retrieves and displays actual historical volume

data for the selected forecast group and time range to serve as

the ground truth for comparison.

1. Expand Admin and click Forecast.

2. In the Available Forecasts table, select one or more Intelligent or Classic

forecasts to view or compare.

Click Filters and select one of the menu options to filter for a specific

forecast, or click the top of each column to sort the forecasts.

Figure 3-1
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Each column in the Forecast table displays the following details about

the forecast: Forecast Name; Model; Forecast Type; Skill Type; 

Associated Group; Timeframe.

3. The graph(s) for the selected Forecasts will display the following:

a. The forecast name and its associated type.

b. Regional Timezone menu - allows you to select the regional timezone.

c. Date Picker - lets you select your desired start and end dates. Days

within your selected timeframe will be highlighted. 

d. Forecast Graph - a visual representation of the forecast data for the

selected date range.

e. Zoom slider - lets you zoom in and out of the date range on the

forecast graph.

Figure 3-2
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4. Click Show actuals and select the checkbox next to a Forecast to view

and compare the actual data from the date range. 

Figure 3-3
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The Actuals data will be displayed. Click Hide Actuals to remove the

Actuals data display.

Figure 3-4
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5. To change the interval view, select Intraday or Daily to display data by

time interval or as a full-day view. Hover your mouse over any point on a

forecast graph to see more details.

Figure 3-5
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6. For Classic forecasts with multiple data series, expand the dropdown

menu next to the forecast and select the checkbox for an option to show

or hide specific elements in the graph. 

Each element in the Classic forecast display is color-coded to match its

representation in the forecast line graph for easy identification.

Figure 3-6

Aspect Cloud Workforce (the New Experience) 42



 Back to top

Admin: View a team or employee schedule

Select team or employee schedule to view

Date Navigation and Time selection

Schedule View Selection

Overview

The Team Schedule View view provides comprehensive schedule visibility for

Admins and Regular users to effectively manage their teams.

As an Admin or Regular user, you can view your team's schedules to confirm

who is working and when. You can see detailed information about each

employee's schedule, including their assigned work.

You can view multiple employee schedules simultaneously to compare and

review your team's work at a high level. Each row represents an employee,

and each column represents a time period.

Figure 3-7

Aspect Cloud Workforce (the New Experience) 43

https://www.notion.so/c8bc9f94cd07822588ff01cde11ab3b8?pvs=25#7f6c9f94cd0782088679818aabb4043e
https://www.notion.so/c8bc9f94cd07822588ff01cde11ab3b8?pvs=25#d46c9f94cd078215ba9f01aeb4cc01aa
https://www.notion.so/c8bc9f94cd07822588ff01cde11ab3b8?pvs=25#06dc9f94cd0782d38b35016f024f79b1
https://www.notion.so/c8bc9f94cd07822588ff01cde11ab3b8?pvs=25#c89c9f94cd07834c892a01bf905efe53


💡 To enable schedule viewing for Regular users, update the user’s

Security Profile in WFM to enable the “Schedule Editor” security

lock. Supervisor access for this feature will be enabled at a later

date.

Select Team or Employees Schedule to view

1. Open the New Experience and log in.

2. Expand Team management, click Team schedules and click Select

Employee Schedules.
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2. Click Groups to select the groups whose schedules you want to view, then

click Next.

3. Click Employees to select the employees whose schedules you want to

view, then click Update View.

Figure 1-1

Figure 1-2
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4. The team schedules for the selected employees are displayed.

5. To view specific employees instead of all team members, click Filter in the

top right and select the employees whose schedules you want to display. 

💡 The New Experience receives the latest employee group details from

the WFM system.

Figure 1-3

Figure 1-4
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Date Navigation and Time selection

Admins can use the date picker to navigate to different dates and view

historical and future schedules for their team.

1. Click the calendar icon to select a date and view the team schedule for

that day. Use the time selector to display schedules within a specific time

period. 

Figure 1-5

Figure 2-1
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💡 Time Range across Multiple Dates

Schedules span multiple days based on the selected time range.

For example, selecting 7pm to 7am displays rollover shifts across

two days.

Schedule View Selection

Admins can expand an employee's schedule row to view detailed information

about individual activities, including activity types, durations, containers, and

segments.

1. Click the arrow next to the employee's name to expand or collapse the row

and view detailed activity information.

Figure 2-2
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2. Hover over a schedule to see more details. 

Back to top

Admin: Edit a team or employee schedule 

Figure 3-1

Figure 3-2
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💡 The Team Schedules view presents a modern, streamlined interface

that lets administrators view, create and edit employee schedules

quickly and confidently. 

It features drag-and-drop scheduling, advanced filtering with

reusable presets, and customizable workspaces designed to reduce

clicks, eliminate repetitive steps, and improve clarity.

💡 Schedule editing is available to Admins and Regular users with the

appropriate permissions in WFM.

To enable schedule editing for Regular users, update the user’s

Security Profile in WFM to enable the “Save as Official” security lock.

Supervisor access for this feature will be enabled at a later date.

1. Open the New Experience and log in.

2. Expand Team management, click Team schedules and click Filter on the

right side of the screen.
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3. Select specific Groups and Employees.

3. Select the date and time to view the schedule timeline. Click the arrows to

expand individual employee rows for detailed activity information.

Figure 1-1

Figure 1-2
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4. Drag and drop the schedule component to the desired time slot.

5. The side panel displays with the updated time and date. You can also

change the time directly in the Edit Activity panel. Fill Memo if needed.

Click Save changes to apply your changes.

Figure 1-3

Figure 1-4
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5. If needed, you can Delete the schedule edit.

6. Click Review changes.

Figure 1-5

Figure 1-6
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8. Any violations will be listed, allowing you to edit the schedule to correct

them.

💡 Click common scheduling rules to view them if needed.

9. Select Edit to make changes to the schedule and correct the violations.

Figure 1-7

Figure 1-8
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10. Click Validate and Publish to apply the changes.

10. The schedule edits are now applied.

Figure 1-9

Figure 1-10
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Back to top

Admin: Create a New Activity for an employee

💡 An admin can select an employee and add a new segment to their

schedule.

1. Open the New Experience and log in.

2. Expand Team management and click Team schedules.

3. Click the + icon next to the row of the employee's schedule.

Figure 1-11
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2. Select the activity you want to add, and enter the start and end times.

Click Add Activity. Add a Memo if needed.

3. The activity now appears in the row of the employee's schedule. Click 

Review Changes.

Figure 1-1

Figure 1-2
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4. Any violations will be listed, allowing you to edit the schedule to correct

them.

💡 Click common scheduling rules to view them if needed.

9. Select Edit to make changes to the schedule and correct the violations.

Figure 1-3

Figure 1-4
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4. Click Validate and Publish to apply the changes.

5. The new activity is now added.

Figure 1-5

Figure 1-6
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Back to top

Admin: Configure automatic schedule updates based on adherence

💡 Automatic schedule updates is a new Aspect Cloud Workforce

feature that uses Aspect Intelligence to automatically add a schedule

segment to an employee’s schedule when a schedule alarm occurs

and then clears.

1. Open the New Experience and log in.

2. Using the Left Navigation Menu, expand Admin and select Workflow

Catalog. The Workflow Catalog page displays. 

💡 The Workflow Catalog allows admins to add a segment to an

employee's schedule when a triggered adherence alarm is created.

Admins can select a category—such as Begin Shift Early, Begin Shift

Late, End Shift Early, or End Shift Late—and add segments that

determine whether the agent receives pay for those time periods.

Figure 1-7
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3. Click + Create new workflow to create a new workflow. The button

appears in the center of the screen when no workflows exist, or in the

upper right corner if a catalog already exists.

Figure 1-1

 Figure 1-2
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4. The Workflow Builder page displays. Type a name for the workflow in the

field provided.

5. Select an Alarm Definition from the drop-down list to start building your

workflow. Alarm Definitions can be configured in the WEM Thick Client /

Figure 1-3

Figure 1-4
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Aspect Workforce. For more information see Alarm Definition in Aspect

Cloud Workforce Perform.

💡 This predefined threshold shows the minimum time required for

the alarm. Using the default  threshold is optional.

6. Enter the Workflow Threshold in the space provided. This section allows

you to set an additional threshold beyond the default threshold preset in

Alarm Definition. 

Figure 1 -5

Figure 1 -6
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💡 The Alarm Definition default threshold determines whether the

alarm is recorded. The workflow threshold determines how long

after the alarm starts before the workflow runs. Since the

workflow can only trigger if an alarm is recorded, there are

scenarios where a workflow may not trigger as expected. For

example, an alarm may be recorded because the agent

exceeded the Alarm Definition Default Threshold, but no

segment is added because they didn't exceed the Workflow

Threshold.

                      Figure 1-7
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💡 The workflow threshold provides optional sensitivity on top of

the alarm’s default threshold. If the workflow threshold is less

than the alarm definition threshold, the workflow may not trigger.

The default threshold preset number represents minutes. Note

the following thresholds.

Numbers only

0 (zero) is the default

Does not allow negatives

Does not allow decimals

Maximum of 1439 minutes

7. Select the employee group for this workflow using the Employee group

drop-down list. You can select multiple employee groups from the list.

💡 This section lets admins filter alarms to trigger only for specific

employees. Employees excluded from the selection will not

trigger the workflow. An All Employees option is available.
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8. When you are done, click Continue to action.

9. On the Action section, select the segment from the Select Segment drop-

down list.

Figure 1-8

Figure 1-9
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💡 The admin doesn't need to select which employee receives the

segment—the workflow automatically determines this based on

who triggered the alarm. A dropdown will appear for the admin to

select which segment to add to the schedule. If the selected

segment requires a container per the Segment Entry Rules, a

container option will be provided.

10. Under Determine rounding, select an option for the Start time rounding

and Stop time rounding using the provided fields.

💡 Schedule Alarms track time down to the second, but Segments

must be added by the minute. You can round the alarm's start

and stop times when adding them as segments. Choose from

these options:

Round to the nearest minute (default)

Round down

Round up

Figure 1-10
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11. Click Save to save the workflow with an Inactive status, or click Save and

Enable to set it to Active.

Figure 1-11

Figure 1-12
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Figure 1-13
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💡 To modify a workflow in the Workflow Catalog screen, click the 

three-dotted menu (…) of the workflow you want to change.

Select Edit workflow to open the Workflow Builder, Enable or 

Disable to update the workflow's status, or Delete to remove it

from the list.

12. When a workflow triggers and adds a segment to an employee's

schedule, the segment's memo will include information indicating it was

automatically added and the name of the workflow that created it.

Figure 1-14
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💡 Additional Information: 

A new user will be automatically added to the Admin's WEM

account to process the workflow in the background.

If a customer experiences issues with triggered workflows,

disable the workflow and contact the Aspect Support Team.

Only one alarm definition can be selected per workflow, but you

can create multiple workflows for different alarms.

Avoid creating workflows that use the same alarm definition and

can trigger for the same employee. The system uses an internal

ranking system that prioritizes the oldest active workflow first.

Workflows trigger on cleared alarms. Once the alarm clears, the

segment is added immediately. The workflow will not trigger the

instant an agent is out of adherence—that means the alarm has

started but not yet cleared.

Back to top

Admin: GDPR Compliance

Overview

This article explains how to secure user and employee data to comply with

GDPR requirements.

⚠️ To delete or remove an employee user in the New Experience, you

must use the WFM procedures because Employee users are sourced

from WFM. 

Admin users are not sourced from WFM, so you can delete or

deactivate them directly in the New Experience.

Right to Erasure
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Workforce Management satisfies the right to erasure by providing the tools

and procedures

documented in this article.

Delete an Employee

You can easily delete an employee you've just added—for example, if you

created an employee record by mistake. However, if the employee has been

associated with other Aspect Workforce Management information (particularly

official schedules), it's usually better not to delete them. Instead, terminate

and inactivate the employee to maintain the integrity of your tracking history,

especially intra-day performance information.

To delete an employee:

1. Open the Workforce Management client.

2. Navigate to Employees > Employee Records.

3. Select the employee to delete and select Special > Change Employee

Status.

4. Terminate the employee, using the Change Employee Status option. 

5. On the Change Employee Status dialog box:

a. Under Employee Status, select the Change To option.

b. Select the Terminated option and specify the termination date. The

termination date

must be the current system date or a previous date.

6. Delete all data records that refer to the employee explicitly and that block

employee

deletion. To view these cross-references, select the employee and select 

Tools > Show

Cross-References, which opens the Cross Reference Summary dialog

box.

7. If the employee is an employee user, use the Users Administration module

to change that

user to an inactive, regular user.
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8. In the Employee Records grid, select the employee.

9. Select Edit > Delete and confirm your choice when prompted.

⚠️ Deleting the employee removes any remaining cross references,

such as trial schedule

assignments. The Cross Reference Summary dialog box (mentioned

in step 6) displays the dependent data types and the number of

records of each type that exist in the database. The content below

lists these data types and indicates which types block deletion of an

employee record.

Delete a User

As with most types of data, you can delete a selected user by selecting Edit > 

Delete. However,

if there is data associated with the user, you must either delete it first or

associate it with another

user. The Delete option itself enables you to easily perform the latter

alternative.

After you select Yes at the confirmation prompt, the Delete Users dialog box

opens. Here you

can associate a different user with the data associated with the user, or users,

you are deleting.

The data associated with a user consists of various types records that the

user created or

updated and that have an Updated By column in the associated grid. If there is

no such data,

you can select the second option (Delete the selected users if there is no data

associated

with them).

If there is associated data with a user, select the first option (Associate all data

with another

user and delete the selected users) and specify a different user to be

associated with the data. For best results, select a “dummy” user that you
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have created only for this purpose, as

opposed to an actual user. For example, you might choose the user name

deleted_user.

After you click OK and the deletion is finished, this user name appears in the

Updated By

column of all grids containing associated records.

Delete Contact Definition

A Contact Definition is a person whom users can communicate with by the

way of email, instant messaging, or telephone.

To delete a Contact Definition:

1. Navigate to Administration > Contact Definitions, and select the contact

to be deleted.

2. Right-click on the contact and choose Delete.

Delete Autorun

Reports can be sent to email addresses, either using contact definitions or

literal email. Literal

emails will need to be found using a SQL command: select * from

AUTORUN_PROC

where PROC_PAR LIKE '%John.Doe@aspect.com%' The autorun jobs found

by the above query will need to be deleted or changed to remove the email.

Delete Logs

In addition, some log files may need to be addressed by your system

administrator:

Windows Event Viewer - This will expire automatically.

WFM Event Viewer - this will expire automatically (based on system clean-

up).

AMR log - This isn't always enabled, but if it is, it will need to be manually

deleted by your

system administrator.
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RTA log - This will need to be deleted by your system administrator.

IIS log - This isn't always enabled, but if it is, this will expire automatically.

WFO log - this will expire automatically.

WFMData log - this will expire automatically.

Right to Data-Portability

Workforce Management satisfies the right to data-portability by providing the

tools and

procedures documented in this article.

View Employee Information

You can view employee information using the Employee Records module in

Workforce

Management.

The following modules are used to add, view, and change the information for

individual and

multiple employees, including their IDs and status information, extra field

information, employee

group assignments, and schedule preferences.

The primary modules for viewing employee information are:

Employee Records, which lets you add, view, and operate on individual or

multiple

employees in a master list. You enter and view each employee's

information using the

Employee Information form.

Employee Information form, which provides a quick way to edit a single

employee record.

Employee Reports, which allows you to view user-selected information on

each of your

employees.

The Employee Information Form
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Use the Employee Information form to enter and view information about a

specific employee. This form is accessible from several modules.

Enter the information on the following pages, as needed:

General—Enter the essential identification and status information about

this employee, such

as name, ID, email address, and hire date.

Extra Information—Enter extra information about the employee on one or

more extra

information pages set up by an administrator.

Group Assignments—Assign the employee to one or more employee

groups.

Skills—Enter the employee’s skill associations.

ACD Login ID—Enter the employee’s ACD login IDs (optional).

Employee Information Reports

Aspect Workforce Management provides several employee information

reports you can preview,

print, and export. The following Employee Information reports are available:

Employee Information - E-mail Address - This report shows each

employee’s ID, name

seniority, hire date, termination date, and e-mail address. Report details

are grouped by

employee group.

Employee Information - Extra Fields - This report shows each employee’s

name and

seniority, plus as many as four employee extra fields. Report details are

grouped by

employee group.

Employee Information - General - This report shows each employee’s ID,

name, seniority,

hire date, termination date, and time zone. Report details are grouped by

employee group.
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Employee Information - Instant Message Address - This report shows the

employee ID,

name, seniority, hire date, termination date and instant message address.

Report details are

grouped by employee group.

To create employee information reports, open the Reports module, select 

Employee Reports,

then select Employee Information reports, and choose the desired report, and

select File >

Print.

Previewing a report lets you see exactly how it will look when you print it. And,

while previewing,

you can print or export the report at any time.

View User Information

You can view user information by accessing the Users Module in Workforce

Management.

To access the Users Module, navigate to Administration > Access Control > 

Users. Complete the user name field to find a specific user, or select the All

check box and click the Retrieve button to display all users. You can then view

user information by double-clicking a user record.

Right to Rectification

You can rectify erroneous information by editing employee and user data in

Workforce

Management. This section describes the tools and processes that Workforce

Management

provides in order to rectify data.

Edit an Employee

You can rectify employee information by using the Employee Information Form

as described in

The Employee Information Form.

Edit a User
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You can rectify user information using the Users module ad described below.

To edit a user:

1. Open the Users module (File > Open) or select Administration > Access

Control > Users in

the navigation tree.

2. Complete the user name field to find a specific user, or select the All

check box and click the

Retrieve button to display all users.

3. Double-Click the user to be edited, displaying the User form.

4. On the General Page, you can type over the User Name and Alternate

User Name.

5. On the Access Page, you can type over the Login ID, First name, and Last

name.

6. Click Save and Close when you are finished editing the user.

Back to top

Employee Schedule Management 🗓️
Employee: Dashboard overview

💡 The New Experience employee dashboard serves as a central hub

for employees after login. It consolidates essential workforce metrics

for easy viewing and access while empowering employees to

engage more effectively with tasks and responsibilities.

1. The New Experience is organized into four main sections that that are

viewable from the left-hand navigation menu.

Dashboard: Click Dashboard to return to the Dashboard at anytime. 

Scheduling: Expand Scheduling and click My schedule to open the 

Schedule view. Optionally, you can select My requests, My balances, 
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Trade board, or Shift Bids.

My Performance: Click My Performance to open the Performance

Hub.

Notifications: Click the Notifications icon > View all to open the 

Notifications view.

Click your profile icon to configure personal settings, adjust your

timezone, enable web browser push notifications, or log out. 

2. The dashboard contains the following widgets:

Performance widget: The Performance widget displays key

performance indicators including Compliance Time, Adherence Time,

Average Handle Time, and Total Inbound Calls Handled. It shows

month-to-date data with trends comparing performance to the same

date range in the previous month. Click any displayed KPI or Month to

Date Performance to see the metric displayed from the Performance

Hub page.

Figure 1-1
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Schedule widget: The Schedule widget provides a streamlined view of

your current day's schedule upon login, displaying shift times and

work types with clear time intervals and durations. Use the arrows in

the top right to navigate to previous and upcoming days' schedules.

Click Today to return to the current day's schedule. The highlighted

area indicates the current activity. 

Status Updates widget: The Status Updates widget displays near real-

time status updates for shift trade and exchange requests.

Figure 1-2

Figure 1-3
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Back to top

Employee: Navigate the Schedule view

1. Open the New Experience and log in. 

3. From the left-hand navigation menu, expand Scheduling and select My

schedule. You can return to the Schedule view at any time by clicking My

schedule under Scheduling.

3. On the right side of the screen, click the Calendar icon to select a specific

date.

Figure 1-4

Figure 1-1
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4. Click the toggle arrows next to the calendar icon to change the schedule

view by day, week, or month. This will reflect in the Week of… date

shown on the left side of the screen. 

⚠️ The purple timeline shown in the day and week views indicates

the current time. See how to adjust the timezone or time format. 

Figure 1-2
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5. To change the calendar display of the Schedule view, click the drop-down

menu next to the calendar icon and select day, week or month. The

toggle options for the calendar icon menu will reflect the current selection.

Click Today to return to the current day’s view. 

Figure 1-4 shows the Day view.

Figure 1-3

Figure 1-4
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Figure 1-5 shows the Month view. To view the Activity details for a

specific day from the month view, click the + icon to expand the

activity menu. The purple timeline will not be visible in the month view.

Back to top

Employee: Select an Activity and view the details

1. Open the New Experience and log in. 

3. From the left-hand navigation menu, expand Scheduling and select My

schedule.

Figure 1-5
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3. Click an Activity to view the details. 

The Activity type, the time and date, and the duration of the Activity

will appear in the View panel on the right side. 

4. In the View panel, click an individual Activity to see a visual

representation of how the Activity fits within your entire work day. The Edit

Figure 1-1

Figure 1-2
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and Delete buttons are available at the bottom of the View panel. See how

to submit a change request to an existing activity. 

5. To view details for multiple activities, click an Activity, then press CTRL 

and click the other desired Activities. The details for all selected Activities

will appear in the View panel.

Back to top

Figure 1-3

Figure 1-4
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Employee: Configure and apply an Activity Template

💡 An Activity Template lets you create automated requests to

rearrange your schedule or set up recurring activities based on your

preferences and current schedule.

1. Open the New Experience and log in.

3. From the left-hand navigation menu, expand Scheduling and select My

schedule. 

3. On the My schedule page, click New Request.

Figure 1-1
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4. Click Configure Activity Templates.

5. Complete the following fields in the Activity Templates window, then click 

Save Template and close the window when you are done:

Template Name: Type a Name for the desired template. 

Figure 1-2

Figure 1-3
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Shift: Select the Work Days for the preference and add the Earliest

and Latest times you want to start and end the shift.

Activities: Select an Activity for the template from the drop-down

menu and add the Earliest and Latest times to start and end the

Activity. 

The available Activity Types will depend on your businesses

configuration and your uniquely defined user permissions. 

Click the Trash icon to delete the Activity Preference or click the 

Duplicate icon to clone the Activity Preference.

Repeating Activities: Select a Repeating Activity for the template

from the drop-down menu and add the Earliest and Latest times to

start and end the Repeating Activity. Then add how often you want to 

repeat the activity and if you want to repeat it by day, week, month, or

year. Then add a Starts on date and an Ends on date. Click the Trash

icon to delete the Repeating Activity or click the Duplicate icon to

clone the Repeating Activity.

Aspect Cloud Workforce (the New Experience) 89



6. To edit an existing Activity Template, click New Request > Configure

Activity Templates, select the Template you want to edit, make the

desired edits, click Save Template and close the window when you are

done. 

Figure 1-4
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7. To apply an Activity Template, click New Request > Apply Activity

Template and click the desired template.  

8. After the Activity Template is applied, the changes will automatically

appear in the View panel. Click an Activity Template Change to expand

Figure 1-5

Figure 1-6
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the details and make any edits. Repeat this step for all Activity Template

Changes. 

9. Scroll down and add a comment if needed. Expand Additional Options,

select the check box next to Allow partial approval and click Submit

Request. 

⚠️ Allowing partial approval gives the option for the requests to be

approved by DATE, not by the individual change request. If some of

the requests are not approved, edit the request changes

appropriately and resubmit them. 

Figure 1-7
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Back to top

Employee: Check Availability by Group or Account

1. Open the New Experience and log in.

2. From the left-hand navigation menu, expand Scheduling and select My

schedule. 

Figure 1-8

Figure 1-1
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3. Click the drop-down menu next to Availability, select the desired Group or

Account from the availability layers, and select the Availability checkbox

to display the latest availability balances. 

4. The calendar display will automatically update to show the latest

availability balances. Hover over an Activity or open shift to display more

details about the availability balances.

Staffing group: A color-coded calendar view that displays Work

Available in purple and Time Off Available in yellow, reflecting current

business needs. Hover over either Work Available or Time Off

Available to display more information.

Personal Account: Located at the top of the calendar display that

shows the selected Personal Account's available time balance. 

Group Allowance Account: Located at the top of the calendar display

and shows the selected Group Account's available time balance.

Figure 1-2
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💡 The My Balances table displays an employee’s used, current, and

future personal time balances in an easy-to-navigate format. 

Back to top

Employee: Submit a Change Request to an existing Activity with Approval

Prediction

1. Open the New Experience and log in.

2. From the left-hand navigation menu, expand Scheduling and select My

schedule. 

Figure 1-3
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3. Click on the Activity you want to change and click Edit. The New Request

window will appear on the right side of the screen. Optionally, you can 

drag and drop Change Requests. 

4. The new Request Change will be labeled Change #1 on the right side of

the screen. Select an Activity from the Activity Type drop-down menu. In

Figure 1-1

Figure 1-2
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this example, WORK is selected.

💡 The available Activity Types will depend on your businesses

configuration and your uniquely defined user permissions.

5. Click the Start field and use the calendar options to select the new shift

date and start time. Click the End field to select the new shift date and end

time.

Figure 1-3
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6. After selecting the new shift date and times, you will see the New Activity

appear in a container with a dotted line (this means it has not been

approved yet). The Original Activity will remain highlighted and is also

shown in the View panel. 

Figure 1-4

Figure 1-5
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7. Expand Approval Prediction, select an option from the Staffing Group, 

Personal Account, or Group Account drop-down menus, and click Show

Prediction to see the approval probability.

This feature uses predictive analytics to determine if your request fits

within your account’s schedule balance. If you’re request prediction

says Likely to be approved, then your request is compatible with your

account’s schedule balance. If you’re request prediction was

disapproved, edit your request to a better suited date and time and

resubmit (predictions are not 100% accurate and may change).

8. If the selected activity requires a container per segment, the Container

Type option appears. Select the container you want from the Container

Type drop-down list above the Comment section.

Figure 1-6
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💡 The system uses Intelligent Container Detection to determine

when containers are needed, which type to use, and

automatically adds them to schedule change requests based on

WFM's Segment Entry Rules.

Some Activity Types may have an assigned segment  container.

If the selected activity type was defined in WFM, the Container

Type option appears.

9. Optionally, add a comment and click Submit Request. 

Figure 1-7
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10. The request will be sent for evaluation. See the Request Change details

on the right side of the screen. Check your notifications to see is the

Request Change was approved or disapproved.

Back to top

Employee: Submit an Add Activity request with Approval Prediction

Figure 1-8

Figure 1-9
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1. Open the New Experience and log in.

2. From the left-hand navigation menu, expand Scheduling and select My

schedule. 

3. Click New Request > Add Activity. 

Figure 1-1

Figure 1-2
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4. The New Activity will appear on the right side of the screen as Change #1.

Select an Activity from the Activity Type drop-down menu. Work is

selected in this example. 

⚠️ The available Activity Types will depend on your businesses

configuration and your uniquely defined user permissions. 

5. Click the Start field and use the calendar options to select the start date

and start time of the new Activity. Click the End field to select the end

date and end time of the new Activity. 

After selecting the new Activity date and times, you will see the New

Activity appear in your schedule view with a dotted outline (this

means it has not been approved yet). 

6. Expand Approval Prediction, select an option from the Staffing Group, 

Personal Account, or Group Account drop-down menus, and click Show

Prediction to see the approval probability. 

This feature uses predictive analytics to determine if your request fits

within your account’s schedule balance. If you’re request prediction

Figure 1-3
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says Likely to be approved, then your request is compatible with your

account’s schedule balance. If you’re request prediction was

disapproved, edit your request to a better suited date and time and

resubmit (predictions are not 100% accurate and may change).

5. If the selected activity requires a container per segment, the Container

Type option appears. Select the container you want from the Container

Type drop-down list above the Comment section.

⚠️ The system uses Intelligent Container Detection to determine

when containers are needed, which type to use, and

automatically adds them to schedule change requests based on

WFM's Segment Entry Rules.

Some Activity Types may have an assigned segment  container.

If the selected activity type was defined in WFM, the Container

Type option appears.

6. Optionally, add a comment to the request and then click Submit Request. 

9. The request will be sent for evaluation. See the Request Change details on

the right side of the screen. Check your notifications to see is the New

Figure 1-4
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Activity was approved or disapproved.

Back to top

Employee: Submit multiple Change Requests at once

1. Open the New Experience and log in.

2. From the left-hand navigation menu, expand Scheduling and select My

schedule. 

Figure 1-5
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3. Prepare an Add Activity request or a Change Request for an existing shift

as Change #1, but do NOT click Submit Request. Click Add Activity. 

💡 The system uses Intelligent Container Detection to determine when

containers are needed, which type to use, and automatically adds

them to schedule change requests based on WFM's Segment Entry

Rules.

Some Activity Types may have an assigned segment container. If

the selected activity type was defined in WFM, the Container Type

option appears.

Figure 1-1
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4. Minimize Change #1 so you can see Change #2 on the right side of the

screen, then complete the fields for your Change #2 request. Repeat steps

2-3 to prepare as many change requests as you need. 

5. Minimize all Change Requests and add a comment if needed. Optionally,

expand Additional Options and select the check box next to Allow partial

Figure 1-2

Figure 1-3
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approval. Click Submit Request.

⚠️ Allowing partial approval gives the option for the requests to be

approved by DATE, not by the individual change request. If some of

the requests are not approved, edit the request changes

appropriately and resubmit them. 

6. The request will be sent to your manager for approval. See the Change

Request details on the right side of the screen. Check your notifications to

see is the new request was approved or disapproved.

Figure 1-4
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Back to top

Employee: Use the drag and drop feature when editing your schedule

1. Open the New Experience and log in.

2. From the left-hand navigation menu, expand Scheduling and select My

schedule. 

Figure 1-5
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3. Click and hold on the Activity that you want to move.

4. Drag the Activity to the desired location and drop it by releasing the click.

5. The Request Change panel will appear and the details will display on the

right side of the screen. 

Figure 1-2

Figure 1-3
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6. Click the border of the any Activity to drag the timeframe up or down.

Back to top

Employee: Submit a Shift Trade request

💡 With Shift Trading, employees can offer their scheduled shifts to

coworkers through one-way trades. This feature works with existing

WFM trade processes and rules, keeping employees updated

through notifications about their trade status. We suggest employees

work out the trade request details offline before submitting the

request.

1. Open the New Experience and log in. 

2. Click Scheduling from the left panel and from the drop down select My

schedule.

3. Click New Request >Trade Shift.

Figure 1-4
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4. Click I want to offer my shift to someone and click Continue. 

5. In the Trade Request panel, complete the steps below and click Continue.

In the Start and End fields, click the date-selector to choose the date

and times for the shift you want to trade.

Deselect the All day checkbox if you want to trade a part of your shift.

Figure 1-1

Figure 1-2
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The New Experience supports selecting a range covering all or

parts of a shift across multiple days (for example, All day—June 11

to June 14, or June 11 at 1:00 PM to June 12 at 11:00 AM). 

Depending on your organization's activity handling rules in Aspect

Workforce, all-day activities (such as Vacation) may not be

tradeable even though they appear in the preview.

6. Click With an Agent to trade your shift directly with a specific employee.

Click Post to Trade board if you want to post your shift trade to the Trade

board. In this example, we selected With an Agent. 

Figure 1-3
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7. The Select Co-Worker section will appear. In the Who would you like to

trade with? field, enter the email of the person you want to trade shifts

with, then click the search icon and select the employee. 

💡 An employee can send multiple Shift Trade requests for the same

day to multiple employees. The first employee to accept a request

for a that day will receive the shift. The trade requests for the other

employees will be voided.

Figure 1-4
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A sample employee lookup is shown below.

8. In the Memo field, enter a brief note explaining the reason for the trade,

then click Submit Trade. A confirmation message will appear to let you

know your trade request was submitted successfully. A trade may be

unsuccessful if it violates a business rule. 

Figure 1-6
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9. The Shift Trade request is now in Pending status. Here are the different

Shift Trade request statuses and what they mean. 

Figure 1-8
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💡 Shift Trade request statuses are updated automatically.

Pending: The Shift Trade request is processing but not yet in

sync with the WFM database. The request cannot be cancelled

in this status. 

Open: The Shift Trade request is currently open and can be

canceled. A Cancel Trade button appears at the end of the trade

summary.

Accepted: The Shift Trade request has been accepted by the

receiver, but is not yet official and still must go through WFM

processing.

Declined: The Shift Trade request was declined by the receiver. 

Official: The Shift Trade request has been accepted and

completed WFM processing. 

Failed: The Shift Trade request failed to process through the

WFM rules successfully. 

Voided: The Shift Trade request was accepted by one receiver,

which automatically voids it for any other employees who

received it. 

Cancelled: The Shift Trade request was cancelled by the sender.

See how to cancel a Shift Trade request.

See how to accept or decline Shift Trade request Notifications.

Back to top

Employee: Submit a Shift Exchange request
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💡 With Shift Exchanges, employees can send or receive shifts for

specific desired times. This feature allows employees to select shifts

and specify their preferred exchange times through an interactive

calendar interface.

Depending on your organization's activity handling rules in Aspect

Workforce, all-day activities (such as Vacation) may not be tradeable

even though they appear in the preview.

1. Open the New Experience and log in. 

2. Expand Scheduling, then select My schedule from the drop-down menu.

3. Click New Request > Trade Shift.

Figure 1-1
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4. Click I want to exchange shifts with someone and click Continue.

5. Under My Shift #1, in the Start and End calendar fields, select the dates

and times for the shift you want to exchange. Select the All day checkbox

if you want to trade your entire day shift.

Figure 1-2

Figure 1-3
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6. Click Add Time Block to add multiple shifts to the request. When you are

done, click Continue.

7. Click With an Agent to exchange your shift directly with a specific

employee. Click Post to Trade board if you want to post your shift

exchange to the Trade Board. In this example, we selected With an Agent. 

Figure 1-4

Figure 1-5
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8. Type the email address or name of the employee you want to exchange

the shift with and press Enter. Select the Employee and click Continue.

9. A preview of the selected employee's schedule is displayed. 

Figure 1-6

Figure 1-7
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The Total hours exchanged indicator shows the number of hours given

and received in the exchange, alerting you if hours are exceeded. 

Optionally, add a note in the Memo field and click Submit Trade.

Figure 1-8
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10. Your shift exchange request has been successfully submitted.

Figure 1-9
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Back to top

Employee: Cancel a Shift Trade or Exchange Request

💡 The sender of a Shift Trade or Exchange request can only cancel if

the request is in Open status. There are two ways the sender can

cancel a Shift Trade request:

From the Schedule view

From the Notifications view

From the Schedule view

1. After you submit the Shift Trade request, a confirmation message will

appear on the right side of the screen.

2. Once the request updates to the Open status, click Cancel Request.

Figure 1-10
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3. Click Cancel Trade.

4. A notification will be sent to the sender and receiver indicating the Shift

Trade request has been cancelled. 

From the Notifications View

1. After you submit the Shift Trade request, you'll receive a notification

message. Click to open it.

2. Confirm the Shift Trade request is in Open status and click Cancel.

Figure 1-1

Figure 1-2
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3. Click Cancel Trade.

4. A notification will be sent to the sender and receiver indicating the Shift

Trade request has been cancelled. 

Back to top

Employee: View the My Balances table

Figure 2-1
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💡 The My Balances table displays your used, current, and future

personal time balances in an easy-to-navigate format. You can filter

and sort transactions to track changes in your balances over time.

1. Open the New Experience and log in.

2. From the left-hand navigation menu, expand Scheduling and select My

balances. 

3. View the details of the table structure below:

Date: Date navigation lets you view balances and transactions for

specific time periods by selecting different dates.

Category: Displays the type of transaction.

Amount Changed: The number of hours added or subtracted.

New Account Balance: Displays the updated total balance after the

transaction.

Total Remaining Balance as of: Displays your current balances with a

timestamp (for example, "as of 06/12/25: +40:00").

Figure 1-1
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4. To select a different balance category, click the dropdown menu and

choose your preferred option. 

5. To apply a filter to the Balances table, click Filter and select Date or 

Category.

Figure 1-2

Figure 1-3
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Apply a Date Filter:

a. When applying a Date filter, select is between to filter for a date range,

or select equal to (=) if you want to filter for a specific date. Select 

exclude (!=) if you want to exclude certain dates. 

Figure 1-4
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b. Then select your start and end dates using the date selectors and click 

Apply. 

Figure 1-5
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c. The table will automatically update with your applied filter choices.  

Apply a Category Filter:

Figure 1-6

Figure 1-7
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a. When applying a Category filter, select contains, then enter the name

of the Category and click Apply. When selecting equal to (=), the

category entered must be an exact match. Select exclude (!=) if you

want to exclude certain Categories. 

b. The table will automatically update with your applied filter choices. 

Back to top

Employee: View the My Requests table

Figure 1-8
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💡 The My Requests table helps employees track their schedule change

requests outside of the notification center. It provides a

comprehensive view of request status, waitlist position for pending

requests, detailed denial reasons, and the ability to revise and

resubmit requests.

1. Open the New Experience and log in.

2. From the left-hand navigation menu, expand Scheduling and click My

Requests.

3. The My Requests table displays the following information for all of your

current requests:

Activity type

Date the request was submitted

Date and time for the schedule change request

Figure 1-1
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Comments

Status (if a request is disapproved, detailed reasons are included)

Scorecard (shows which specific rules affected the approval or denial

of your request)

4. Click the drop-down menu next to All Activities or All Requests to select a

specific Activity or Request type and filter the table results.

All Activities

All Requests

Figure 1-2

Figure 1-3
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5. Click the expand arrow to see more details about a specific request. If the

request is still in Pending status, you can edit or cancel the request.

6. Click the Scorecard icon to see which specific rules affected the approval

or denial of your request.

Figure 1-4

Figure 1-5
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Back to top

Employee: View Historical Schedule Adherence

Overview

The Historical Schedule Adherence feature tracks how closely an employee’s

actual operations follow their planned schedule. With this feature, employees

can view their Adherence in:

Day View - Displays more detailed information. Hovering the cursor over

the adherence allows the employee to view additional details as well.

Week View - The default view that shows Adherence for the week.

Month View - Displays the percentage of time the employee maintained

schedule adherence for the month. 

➡️ Adherence mode remains active only while you stay on the schedule

page. If you refresh the page or navigate to another section,

Adherence will automatically turn off.

Figure 1-6
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Enable Historical Schedule Adherence view

1. Open the New Experience and log in.

2. From the left-hand navigation menu, expand Scheduling and click My

Schedule.

3. Click the toggle switch to the right to enable the Adherence view. This

will display your Schedule Adherence in the Week of… view.

⚠️ When Adherence is enabled, the following options are disabled in

the Navigation Menu.

Edit my Schedule

Request PTO

Schedule Preference

Figure 1-1
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If you enable Adherence while editing your schedule, you will lose any

unsaved changes. To preserve your edits, click the Cancel button when

prompted.

4. To view more information about Adherence, hover over the Information

icon next to the Adherence type to see the Adherence Legends.

Figure 1-2

Figure 1-3
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The Adherence Legends include the following:

In Adherence - indicates the employee is logged in and actively

working during their scheduled work hours.

Scheduled Offline - indicates the employee's planned offline

period such as breaks and lunch.

Out of Adherence - indicates the employee is unavailable during

their scheduled work hours.

5. The Adherence view displays the following indicators that are visible in

week and month views.  

The Status Indicator provides your workload status.

Figure 1-4
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The Schedule Adherence percentage shows when you click the +*

more icon. 

Back to top

Employee: Submit a Shift Bid

Figure 1-5

Figure 1-6
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💡 Shift Bidding offers employees an intuitive and visually appealing

interface for managing their shift bids. Employees can view, rank,

and manage bids with easy-to-use tools. 

The system features filtering options, drag-and-drop functionality,

and preference settings that enable employees to rank shifts

efficiently based on their personal needs.

1. Employees can access Shift Bids in two ways:

From the left-hand navigation menu, expand Scheduling and click 

Shift bids.

From the upper-right corner, click the Notifications icon and select a 

Shift Bid notification to view the details.

Figure 1-1
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2. Open the Shift Bid Notification and click Start Shift Bid.

3. You will see all Shift Bids assigned to you. Click the pencil icon to the right

of a Shift Bid to view and rank available shifts.

Figure 1-2

Figure 1-3
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4. Click the arrow next to an available shift to expand the shift details.

💡 Working days appear in black and display the corresponding shift

times.

5. Available Shifts can be moved to the Ranked Shifts panel by dragging and

dropping or by clicking the add icon on the left.

Figure 1-4

Figure 1-5
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6. You can reorder your Ranked Shifts by either dragging them up or down,

or by entering a specific rank number in the box beside each shift. When

you've finalized your preferences, click Submit Final Bid.

💡 All shifts must be ranked before you can submit your final bid.

Figure 1-6

Figure 1-7
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7. Click Edit Preferences to edit your rankings after submission.

8. The admin will set the due date for Shift Bid submissions. You will receive

a notification once your Shift Bid has been processed.

Back to top

Employee: View the Performance Hub

💡 The Performance Hub displays a user's historical performance data

gathered from WFM. It allows users to view their performance

through graphical representations.

1. Open the New Experience and log in.

2. In the left panel, click My Performance, or click any KPI in the 

Performance widget.

Figure 1-8
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3. From the Performance Dashboard, click the drop-down menu below the

Performance Hub header and select the type of performance you want to

view. All KPI options in the drop-down list are standard defaults. 

 Figure 1-1

Figure 1-2
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The Performance Hub KPI  options are described below. 

Adherence Percentage - Shows your adherence percentage value.

It's calculated as In-Adherence Time / Schedule Time × 100.

After Call Work - Provides a performance summary for after-call

work.

Average Handle Time - Measures the average handle time per

inbound contact.

Average Talk Time - It’s calculated as (AHT - ACW) AHT - ACW.

Compliance Percentage - Shows the percentage of agents who

were in compliance. Its calculated as Compliance / Scheduled \

100*.

Inbound Calls - The number of inbound contacts handled.

Outbound Calls - The number of outbound contacts handled.

Plugged In Percentage - Shows the percentage of time you were

logged in and available. Its computed as Plugged In / Signed In \

100*.

Total Calls - Shows the total calls answered during the day. Its

computed as NCH + NOC.

4. Click the date field and use the date picker to choose a date range or a

specific day. 

Figure 1-3
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5. Once you're done, the Performance Hub displays a summary of the

agent's performance for the selected time period. Hover over the graph to

view detailed information. Note that details vary depending on the KPI you

selected.

Figure 1-4
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Back to top

Employee: View the Trade Board for Shift Trades or Exchanges

Trade Board Overview

Post a Shift Trade or Exchange Request to the Trade Board

Accept a Shift Trade or Exchange from the Trade Board

Trade Board Overview

Figure 1-5
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💡 The Trade board allows employees to post, search for, and accept

shifts trades (giveaway) or exchanges based on their availability and

skills. It facilitates communication between employees, allowing

them to make more informed scheduling decisions.

Depending on your organization's activity handling rules in Aspect

Workforce, all-day activities (such as Vacation) may not be tradeable

even though they appear in the preview.

1. Expand Scheduling and click Trade board.  You can also access the Trade

board by selecting View Trade on Board after creating a shift

trade/exchange with the Post to Trade Board option.

2. The Trade board displays a list of shift trade/exchange offers. The

dropdown menus at the top offer the following filter options:

Skill - Filter for specific skills or all skills.

Employee - Filter for a specific employee or all employees.

Status - Filter for the status of the request.

Figure 1-1
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3. Click the up/down arrows to the right of each column to use the following

sorting options:

Employee who posted the shift.

The date when the post was submitted.

The date and time of the trade, which can include multiple dates and

times.

The skill required.

The status of the shift. 

Figure 1-2
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4. Click on a post to view additional information.

5. See how to post a shift trade/exchange request to the Trade board, or how

to accept a shift trade/exchange from the Trade board. 

Post a Shift Trade or Exchange Request to the Trade Board

1. Create a shift trade (giveaway) or shift exchange request and under How

do you want to trade your shift, select Post to Trade board.

Figure 1-3
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2. Optionally, select the check box next to Add preference for shift offers,

add comments in the Exchange Preference field, and then click Submit

Trade. 

⚠️ This feature only applies to shift exchange posts and is not available

for shift trade (giveaway) posts.

Figure 2-1

Figure 2-2
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3. The post is now available on the Trade board. Click View Trade on Board 

to view the post. Optionally, click Cancel Trade to cancel the post. 

Accept a Shift Trade from the Trade Board

1. Expand Scheduling, click Trade board and select the shift trade post you

want to accept. 

2. Click Trade Preview to display a preview of how the shift will look on your

schedule.

Figure 2-3
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3. Review how the trade will fit into your schedule and click Pick up Shift to

accept the shift trade. Optionally, click Close to exit the preview.

4. A confirmation pop-up will appear asking if you want to accept the trade.

Click either Confirm or Cancel.

Figure 3-1

Figure 3-2
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⚠️ Trades and exchanges are not finalized until they go through WFM

Trade and Segment Entry rules. Employees will receive notification

alerts when the request is updated. See the Notifications section for

more details.

Accept a Shift Exchange from the Trade board

1. Expand Scheduling, click Trade Board and select the shift exchange 

post you want to accept.

2. Click Trade Preview to display a preview of how the shift will look on

your schedule. 

3. When you are ready to add one of your shifts to exchange, click Offer

Trade. 

Figure 4-1
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4. The Trading with screen will display a private view of the poster’s

schedule. This allows you to see which times you should avoid

proposing for the exchange. 

5. The colored overlays are explained at the top of the screen to help you

understand what you are seeing.

My Schedule (White) - Your current schedule. 

Poster’s Schedule (Green)- The schedule of the employee you are

exchanging shifts with.

Figure 4-2

Figure 4-3

Aspect Cloud Workforce (the New Experience) 157



Poster’s Offer (Aqua) - The shift offered for exchange.

My Return Offer (Grey)- The shift you are proposing to exchange.

6. Click Add Time Block and use the date picker to select the times for

the shift you want to exchange with the poster. 

7. Review the Included Activities and then click Submit Offer.

Figure 4-4

Figure 4-5
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8. Click Return to Board. Optionally, click Cancel Offer.

⚠️ Trades and exchanges are not finalized until they go through

WFM Trade and Segment Entry rules. Employees will receive

notification alerts when the request is updated. See the 

Notifications section for more details.

Back to top

Figure 4-6

    Figure 4-7
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Notification Management 📝
Notifications overview

The Notifications center in the New Experience improves work efficiency by

consolidating status updates for schedule change requests and

announcements into a single, easily accessible location. It ensures that

employees are promptly notified of any changes that require their attention,

enabling quick decision-making and timely responses. 

Employees can view notifications either in the full Notifications Center or

through a quick view, where they can see all notifications displayed

chronologically, along with the status and details of requests and a schedule

preview showing original and new activity requests. Employees can also

enable web browser push notifications, if permitted by the company IT

system.

Employee: Open the Notifications Center

1. Open the New Experience and log in. 

2. There are two ways to view Notifications from within the New Experience:

a. In the Notifications Center.

b. In a quick view.

3. In the upper right corner of the screen, click the Notifications icon and

select View All.
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4. In the Notifications Center, you will see:

All notifications displayed chronologically on the left-hand side. See

how to read and filter or delete notifications.

The status and details of a request at the top of the screen, when an

individual notification is selected. See what to do if your request is

disapproved. 

A Schedule Preview displaying the original activity and new activity

request at the bottom of the screen.

Figure 1-1
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Employee: See a quick view of your recent notifications

1. Open the New Experience and log in. 

2. In the upper-right corner of the screen, click the Notifications icon and

you will see a quick view of your recent notifications. 

The number of unread notifications is shown above the Notifications

icon. Click on a notification to mark it as read. 

Unread notifications are marked with a purple circle next to them,

while read notifications are unmarked. 

Figure 1-2
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3. Click View All to manage updates for your recent notifications.

Alternatively, click a specific notification to manage updates for that

request.

The quick view will display:

The date and time the request was submitted

The status of the request

The date and time the request was approved or disapproved

Figure 1-1
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Employee: Read and filter your notifications

1. Open the New Experience and log in. 

2. In the upper right corner of the screen, click the Notifications icon.

Figure 1-2
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3. Your notifications will appear on the left side of the screen. Click the 

ellipses to show options for marking notifications as read, unread or to 

delete.

To multiselect notifications, hold CTRL with your keyboard and select

multiple notifications with your mouse.

Figure 1-1
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4. To filter notifications, click Requests and select the checkbox next to 

Approved, Disapproved, Pending or Cancelled.

Figure 1-2

Figure 1-3
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Employee: Delete a notification

1. Open the New Experience and log in. 

2. In the upper-right corner of the screen, click the Notifications icon.

3. Select the notification you want to delete and click the trash icon on the

right side of the screen. To multiselect notifications, press Shift, Ctrl, or 

Ctrl+A with your keyboard and select multiple notifications with your

mouse.

💡 Optionally, you can right-click a notification and click Delete

Notification > Delete.  

Figure 1-1
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4. Confirm you want to delete the selected notification and click the check

mark. 

⚠️ Trade notifications for trades in Open status will not be deleted

as part of the Delete All or the right-click Delete Notification

option.

When a sender deletes an Open trade notification using the 

trash icon, they'll receive a warning that this action will both

cancel the open trade and delete the notification. Both the

sender and receiver will then receive a Canceled notification.

When a receiver deletes an Open trade notification using the 

trash icon, they'll receive a warning that this action will both

decline the open trade and delete the notification. Both the

sender and receiver will then receive a Declined notification.

Figure 1-2
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Employee: Create a new request if your request is disapproved

1. Open the New Experience and log in.

2. In the upper-right corner of the screen, click the Notifications icon.

Figure 1-3

Figure 1-1
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3. Find the disapproved request, review the details and comments, then click 

New Request to resubmit.

4. Create and submit a new activity request.

Employee: Accept or decline Shift Trade or Exchange requests

💡 When a sender initiates a Shift Trade or Exchange request, both the

sender and receiver receive a notification containing the request

details. 

1. To open a Shift Trade/Exchange request notification, click the 

Notifications icon in the upper-right corner of the screen, then click the

specific Shift Trade/Exchange notification.

Figure 1-2
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2. You will see a preview of how the Shift Trade/Exchange will look on your

updated schedule. Click Collapse to return to the previous view. 

Figure 1-1

Figure 1-2
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3. To accept the Shift Trade/Exchange request, click Accept. To decline the

Shift Trade/Exchange request, click Decline. 

When a Shift Trade/Exchange is accepted, it must still go through WFM

processing before becoming Official. Both the sender and receiver will

get notification updates with the latest trade status.  

Figure 1-3
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💻 Shift Trade/Exchange request statuses are updated automatically.

Pending: The request is processing but not yet in sync with the

WFM database. The request cannot be cancelled in this status. 

Open: The request is currently open and can be canceled. A 

Cancel Trade button appears at the end of the trade summary.

Accepted: The request has been accepted by the receiver, but is

not yet official and still must go through WFM processing.

Declined: The request was declined by the receiver. 

Official: The request has been accepted and completed WFM

processing. 

Failed: The request failed to process through the WFM rules

successfully. 

Voided: The request was accepted by one receiver, which

automatically voids it for any other employees who received it. 

Cancelled: The request was cancelled by the sender. 

Employee: Enable or Disable Push Notifications

💡 Web Browser Push Notifications enables browser push notifications

for employees, including schedule changes and automatic schedule

updates. This ensures employees don't miss time-sensitive updates

—such as schedule changes, request status change, and messages

sent by Admins.
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💡 Web Browser Push Notification are supported by the following

browsers:

Google Chrome

Microsoft Edge

Mozilla Firefox

1. Open the New Experience and log in.

2. Click the Profile icon and select Personal Settings.

3. Click Notifications.

Figure 1-1
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Figure 1-2
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💡 If your organization's administrator or IT department manages

your browser, the Notification screen will display this:

You can also check this by navigating to your browser settings

and selecting Privacy and Security.

4. Click the toggle next to Enable push notifications. To disable or pause

notifications, click the toggle again.

💡 When you enable push notifications a browser permission

prompt appears asking if you want to allow push notifications in

your web browser.

Figure 1-3

            Figure 1-4
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5. If the Browser push notification toggle is disabled, you may need to

perform additional steps in your web browser.

a. Navigate to the web browser’s setting by clicking the three-dotted

menu and select Settings.

Figure 1-5

Figure 1-6
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b. Navigate to Privacy and Security, then select Site Settings.

Figure 1-7

Figure 1-8
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c. Select Notifications.

d. Ensure that Sites can ask to send notifications is enabled. 

Figure 1-9
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e. Add the URL to the Allowed to send notifications list.

Back to top

FAQ 🔍
Employee FAQs

How do I create, edit or apply an Activity Template?

Create, edit or apply a Activity Template.

Before submitting a schedule change request, how can I check the

available time allowances for my personal and group accounts?

Add a layer to check availability.

How do I request a full day off or a change to my shift?

See how to request a change to your shift. See how to submit a PTO

request.

Figure 1-10
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Will I receive notifications when I submit a request?

Yes. See how to view recent notifications. 

What types of notifications are available?

Only schedule change notifications are available. See how to view recent

notifications. 

I submitted a schedule change request using the New Experience how

does my manager approve it?

Once you submit a request in the New Experience, your Manager can

review the details of your request directly within the WFM or via email

depending on how your classic product is set up.

You will then receive a notification about the status of your request once

your manager has made a decision.

Will the schedule change requests made in the New Experience appear

in WFM, or do I have to submit a request in both products?

Schedule change requests made in the New Experience will automatically

appear in the WFM. You will not need to submit requests in both products.

How do I add extra time to my schedule?

1. Add a layer to check schedule availability.

2. Create, edit or apply a Schedule Preference. 

How will I know if my schedule request for extra time is approved?

Once your request for extra time is approved, you will receive an approval

notification. Check your schedule to see the newly approved time slots

reflected in your calendar.

Why was my schedule request for extra work hours disapproved

automatically?

When an employee submits a request for extra work hours, they will get

denied automatically because of an integration issue with WFM that will be

Aspect Cloud Workforce (the New Experience) 181

https://www.notion.so/c8bc9f94cd07822588ff01cde11ab3b8?pvs=25
https://www.notion.so/c8bc9f94cd07822588ff01cde11ab3b8?pvs=25
https://www.notion.so/c8bc9f94cd07822588ff01cde11ab3b8?pvs=25
https://www.notion.so/c8bc9f94cd07822588ff01cde11ab3b8?pvs=25
https://www.notion.so/c8bc9f94cd07822588ff01cde11ab3b8?pvs=25
https://www.notion.so/c8bc9f94cd07822588ff01cde11ab3b8?pvs=25
https://www.notion.so/c8bc9f94cd07822588ff01cde11ab3b8?pvs=25
https://www.notion.so/c8bc9f94cd07822588ff01cde11ab3b8?pvs=25
https://www.notion.so/c8bc9f94cd07822588ff01cde11ab3b8?pvs=25
https://www.notion.so/c8bc9f94cd07822588ff01cde11ab3b8?pvs=25


resolved in an upcoming version release. See how to perform a

workaround for this issue. 

What actions are available if my schedule change request is

disapproved?

If you receive a disapproved request notification, view the details and

resubmit the request taking the received details into consideration.

How do I start a Shift Trade request?

See how to initiate a Shift Trade Request.

Admin FAQs

How do I invite my team?

1. Log into the New Experience as an Admin. 

2. Send an invite to your employees. 

Where do I approve all the requests made in the New Experience?

Admins will approve requests in WFM for now, but the approval function

will be moved to the New Experience soon.

Are the New Experience and WFM two different products? 

Aspect Cloud Workforce (the New Experience) is separate application that

is designed to provide Admins and Employees an improved user

experience. 

How are the predictions and suggestions for shift changes created?

The predictions and suggestions are based off of the Intra-Day Staffing

Balances, Personal Accounts and/or Group Allowance Reports.

If there is no Staff Group, Personal Account or Group Allowance Account

selected, then the corresponding data won’t be used in the predictions or

suggestions. 
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The Employees can choose if they want Intra-Day Staffing Balances to be

checked by selecting a staff group, or by selecting a Personal Account if

they want Personal Accounts to be checked and by selecting a Group

Allowance Account if they want Group Allowances to be checked.

How are the New Experience and WFM related?

WFM is the engine and database powering the New Experience interface.

Employee schedule’s created in WFM are automatically imported to the

New Experience when the integration between the two is enabled.

How many user roles are there?

There are three user roles; Employee, Regular user, and Admin. Employee

and Regular user email addresses must be registered and activated in

Aspect WorkforceOS, before they can be activated in the New Experience.

You can not add Employee or Regular user emails directly from the New

Experience.

How do I enable Federated Login and what is its functionality?

See the Federated Login overview article for more information.

Troubleshooting ⚠️
Troubleshooting overview

This section provides information on how to run troubleshooting techniques in

Aspect Cloud Workforce (the New Experience).

Reset your password

1. Open the New Experience, select your Account and click Reset Password.

⚠️ If you don’t know your Account name, look for it in your invite email

or contact your Workforce Administrator for more help.
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2. Type your email and click Send Password Reset.

3. Open the “Your verification code” email, copy the reset code and return to

the Reset Password page. Paste the code into the Reset Code field, type

and confirm a new password and click Reset Password. Your password is

now reset.

Figure 1-1

Figure 1-2
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Request extra work hours using a shift container

1. Open the New Experience and log in.

3. From the left-hand navigation menu, expand Scheduling and select My

schedule.

Figure 1-3

Figure 1-1
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3. On the My schedule page, click New Request.

4. Click Add Activity to add Change #1.

5. From the Activity Type drop-down menu, select SHIFT (container) or

another option depending on how your company defines the activity. 

Figure 1-2

Figure 1-3
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6. Select the day you want to add the extra hours, then select the Start and 

End times. The new Shift Container for Change #1 will appear in the 

Schedule view.

7. Click Add Activity to add Change #2.

Figure 1-4

Figure 1-5
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8. From the Activity Type drop-down menu, select WORK or another option

depending on how your company defines the activity.  

7. Select the same day you want to add the extra hours, then select the Start

and End times for the Work shift. The new Work Container will appear in

the Schedule view. 

⚠️ The WORK container hours must not exceed the SHIFT container

hours. 

Figure 1-6

Aspect Cloud Workforce (the New Experience) 188



10. Click Submit Request. Including the WORK container within the SHIFT

container will allow your request to be processed in WFM. 

Back to top

Figure 1-7

Figure 1-8
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Contact Support 🗣️
Contact Support

For any issues you are unable to resolve in the Troubleshooting section,

please contact your Workforce Administrator with your account name and a

description of your issue. 
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